Safety Guidelines

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring to property damage only have no safety alert symbol. The notices shown below are graded according to the degree of danger.

**Danger**
indicates that death or severe personal injury will result if proper precautions are not taken.

**Warning**
indicates that death or severe personal injury may result if proper precautions are not taken.

**Caution**
with a safety alert symbol indicates that minor personal injury can result if proper precautions are not taken.

**Caution**
without a safety alert symbol indicates that property damage can result if proper precautions are not taken.

**Notice**
indicates that an unintended result or situation can occur if the corresponding notice is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and operation of a device/system may only be performed by qualified personnel. Within the context of the safety notices in this documentation qualified persons are defined as persons who are authorized to commission, ground and label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage

Note the following:

**Warning**
This device and its components may only be used for the applications described in the catalog or the technical description, and only in connection with devices or components from other manufacturers which have been approved or recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage, positioning and assembly as well as careful operation and maintenance.

Trademarks

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
Preface

Purpose of this Documentation

This documentation provides you with a full overview of the topics relating to the use of high-precision time stamping:

- Required components
- Interaction of the components
- Configuration of the components

The first section gives you an overview of the option and use cases for high-precision time stamping and is intended for the following readership:

- Future users of SIMATIC PCS 7
- Persons responsible for deciding on the use of a control system
- Sales personnel and system configuration engineers either within Siemens or belonging to other companies

The subsequent sections show the configuration and parameter assignments for high-precision time stamping and is intended for persons involved in the following occupations:

- Conceptual design of PCS 7 solutions
- Device and system programming
- Configuration and commissioning
- Service

Required Basic Knowledge

General knowledge in the area of automation engineering and process control engineering is required to understand this documentation.

It is assumed that the reader knows how to use PCs or other equipment similar to PCs (such as programming devices) operating under Windows operating systems approved for PCS 7.

Differences Between This and the Previous Version

Below you will find an overview of the most important differences between this documentation and that of the previous version:

- Time stamping with 1 ms accuracy
- Time stamping with ET 200iSP
Scope of the Documentation

This documentation applies to the software package Process Control System; PCS 7 Toolset as of V7.0.

Conventions

The names of the elements in the software interface in this documentation are presented in the language of the documentation. If you have installed a multi-language package for the operating system and subsequently switch languages, however, some terms may appear in the basic language of the operating system and therefore deviate from the terms used in the documentation.

PCS 7 Glossary

You can find a PCS 7 glossary defining the most important technical terms used in the documentation on the DVD SIMATIC PCS 7; Manual Collection or within the PCS 7 software through the help menu of the SIMATIC Manager (menu command Help > Topics > “Glossary” button).

Further Support

If you have any technical questions, please get in touch with your Siemens representative or responsible agent.

You will find your contact person at:

http://www.siemens.com/automation/partner

You will find a guide to the technical documentation offered for the individual SIMATIC Products and Systems at:

http://www.siemens.com/simatic-tech-doku-portal

The online catalog and order system is found under:

http://mall.automation.siemens.com/

Training Centers

Siemens offers a number of training courses to familiarize you with the Process Control System SIMATIC PCS 7. Please contact your regional training center or our central training center in D 90327 Nuremberg, Germany for details:

Telephone: +49 (911) 895-3200.

Internet: http://www.sitrain.com
Technical Support

You can reach the Technical Support for all A&D products

- Via the Web formula for the Support Request
  [http://www.siemens.com/automation/support-request](http://www.siemens.com/automation/support-request)
- Phone:  + 49 180 5050 222
- Fax:  + 49 180 5050 223

Additional information about our Technical Support can be found on the Internet pages [http://www.siemens.com/automation/service](http://www.siemens.com/automation/service)

Service & Support on the Internet

In addition to our documentation, we offer our Know-how online on the internet at:
[http://www.siemens.com/automation/service&support](http://www.siemens.com/automation/service&support)

where you will find the following:

- The newsletter, which constantly provides you with up-to-date information on your products.
- The right documents via our Search function in Service & Support.
- A forum, where users and experts from all over the world exchange their experiences.
- Your local representative for Automation & Drives.
- Information on field service, repairs, spare parts and more under "Services".
Contents

1 Basics of High-Precision Time Stamping ................................. 1-1
  1.1 Time Stamping of Signal Transitions ................................... 1-3
  1.2 The Time Stamping Process ................................................. 1-4
  1.3 The Time Stamping Process in the Interface Module .......... 1-5

2 Configuration ........................................................................... 2-1
  2.1 Hardware Configuration ...................................................... 2-1
  2.2 Special Features of the Interface Module ............................ 2-3
  2.3 High-precision Time Stamping with 1 ms Accuracy ........ 2-4
  2.4 System Planning and Configuration ................................. 2-5

3 Components and Systems .......................................................... 3-1
  3.1 Overview: Components and Systems ................................. 3-1
  3.2 SIMATIC Station .................................................................. 3-1
  3.3 Communication Modules .................................................... 3-2
  3.4 Distributed I/O ................................................................. 3-3
  3.5 IM_DRV Diagnostics .......................................................... 3-4
  3.6 Time Master ................................................................. 3-5

4 Configuring Time Stamps .......................................................... 4-1
  4.1 Overview of Configuration Steps ......................................... 4-1
  4.2 Configuring the CPs ............................................................ 4-3
  4.2.1 How to Configure the CP 443-1 (Industrial Ethernet) .......... 4-4
  4.2.2 How to Configure the CP 443-5 Extended ......................... 4-5
  4.2.3 How to Configure the PROFIBUS Connection of the CPU .. 4-6
  4.3 Configuring the ET 200 Station ........................................... 4-9
  4.3.1 Setting Options on the ET 200 Station ............................ 4-9
  4.3.2 How to Configure the Interface Module ......................... 4-10
  4.3.3 Examples of Settings for IM 153-2 Interface Module .......... 4-13
  4.3.4 How to Configure the SM 321 Digital Module .................. 4-15
  4.3.5 Examples of Settings for SM 321 Digital Input Module ...... 4-17
  4.3.6 How to Configure the SM 131 Digital Module ................. 4-18
  4.3.7 Example for the Settings on the Digital Input Module SM 131 . 4-20
  4.4 Configuring the CPU Properties ......................................... 4-21
  4.4.1 How to Configure the CPU Properties ........................... 4-21
  4.5 Configuring the Symbolic Names ....................................... 4-22
  4.5.1 How to Configure Symbolic Names for Signals ............... 4-22
  4.6 Configuring the Input Signals ............................................ 4-24
  4.6.1 How to Configure the Input Signals .............................. 4-24
  4.7 Generating Module Drivers .............................................. 4-25
  4.7.1 How to Generate Module Drivers ................................. 4-25
  4.8 Compiling and Downloading the AS ................................. 4-26
  4.8.1 How to Compile and Download the AS ......................... 4-26
  4.9 Assigning Message Texts .................................................. 4-27
  4.9.1 How to Assign Message Texts ...................................... 4-27
  4.10 Compiling the OS ............................................................ 4-29
  4.10.1 How to Compile the OS ............................................... 4-29
### 5 AS Process Control Messages in the Event of Time Stamp Faults

5.1 Time Stamp Faults
5.2 AS process control message "Startup data"
5.3 AS process control message "Time-of-day message frame error"
5.4 AS process control message "Time difference between the message frame time stamp and the real-time clock may cause inaccuracy"
5.5 AS process control message "STOP of the time stamp function"
5.6 AS process control message "Message loss at IM (buffer overflow)"
5.7 AS process control message "Redundant changeover"
5.8 AS process control message "Redundancy_info_loss error"

### 6 Diagnostics and Troubleshooting

6.1 Overview: Diagnostics and Troubleshooting
6.2 Time Stamp Diagnostics
6.3 How to Check the Message Path
6.4 How to Perform CP Diagnostics
6.5 How to Check the Time in the CPU
6.6 IM_DRV Block
6.7 Redundancy Diagnostics for H Systems
6.8 Diagnostics for the Interface Module

### Index

Index-1
1 Basics of High-Precision Time Stamping

Introduction
This documentation describes the time stamping function for digital input signals. Users can activate time stamping in their system configuration and display the time information in their monitoring system.

Definition
The following is meant when referring to time stamping in this documentation:

The assignment of time information with a high degree of accuracy about the state changes of an acquired process signal.

The detection of changes in digital input signal states and the assignment of time information are performed by SIMATIC components.

Application
Possible applications for high-precision time stamping are:

- Accurately-timed detection of problems in process-related equipment. Time stamping enables you to explicitly identify signals that indicate the cause of the failure of a process unit.
- Analysis of system-wide interrelationships
- Detection and reporting of the sequence of time-critical signal changes

Requirement
The time-of-day must be synchronized on all the devices belonging to the system. The devices are connected to a time master for this purpose.
Basics of High-Precision Time Stamping

Accuracy

The following applies to high-precision time stamping:

- If process signals are acquired from a separate PROFIBUS DP master systems and results arrive simultaneously at the input module, the time stamps of the resulting messages in the HMI system differ by maximum x milliseconds (see table below). The accuracy depends on the I/O used.
- The time stamping does not depend on whether the PROFIBUS DP master systems are located in one or more SIMATIC 400 stations.

<table>
<thead>
<tr>
<th>I/O</th>
<th>Achievable accuracy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ET 200M</td>
<td>1 ms</td>
<td>With ET 200M, you can acquire signals with selected digital input modules with an accuracy of 1 ms. You can find information about this in the section &quot;High-precision Time Stamping with 1 ms Accuracy&quot;</td>
</tr>
<tr>
<td>ET 200M</td>
<td>10 ms</td>
<td>With ET 200M, you can acquire signals with selected digital input modules with an accuracy of 10 ms.</td>
</tr>
<tr>
<td>ET 200iSP</td>
<td>20 ms</td>
<td>With ET 200iSP, you can acquire signals with selected digital input modules with an accuracy of 20 ms.</td>
</tr>
</tbody>
</table>

Resolution

The displayed resolution of the time is 1 ms (regardless of the accuracy).

Advantage

The high-precision time stamping does not depend on cycle times.

Property

- The high-precision time stamping can only be used for digital input modules.

Additional information

- You can find more information about the released digital input modules in the section "Components and Systems".
1.1 Time Stamping of Signal Transitions

**Notice!**
High-precision time stamping should only be used for selected signals that are of importance to the process. They should not be used for every digital signal that is read.

There is a risk that too many signals will be reported at the same time (for example, when a fault occurs). This might result in message loss due to a buffer overflow.

**Time-precise acquisition**

The use of time stamps makes it easier to analyze the causes of problems.

Example

If a boiler used to produce steam fails, this event causes a surge of messages:

- The temperature and pressure fall below a specified limit value, the flame monitor responds, the next plant unit signals "steam low", etc.
- To determine the actual cause of the failure, the first message in this surge of messages must be identified (for example, "gas pressure too low").
- Since a large number of messages will arrive following the failure of a plant unit, a resolution of 1 second for the message time is inadequate. With the aid of time stamps, the signals that led to the shutdown of the boiler are selectively detected. As a result, the operator can evaluate the cause of the shutdown more easily.

**Plant-Wide Interrelationships**

A further aspect of 10 ms time stamping is the determination of interrelationships between units in a plant.

Example

The high-precision time stamping is implemented throughout the plant:

By comparing the time stamps of relevant signals throughout the plant, a momentary quality impairment in a unit can be traced to a problem in another unit.
1.2 The Time Stamping Process

Description

The following table describes the time stamping sequence.

The digital inputs of a module in the distributed I/O station (ET 200M, ET 200iSP) are monitored for signal transitions.

<table>
<thead>
<tr>
<th>Step</th>
<th>Who/Where?</th>
<th>What?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IM</td>
<td>The interface module IM (IM 153-2, IM 152-1) stores the signal state change.</td>
</tr>
</tbody>
</table>
| 2    | IM         | The interface module IM (IM 153-2, IM 152-1) stores the information about an "incoming event" with the current time-of-day in a message list (in the IM). Features:  
  - The time resolution of the time stamping is 1 ms.  
  - Special messages are also saved in the message list (events influencing message processing).  
  - A maximum of 20 messages in a message list form one data record.  
  - An IM stores up to 15 data records. |
| 3    | IM         | The interface module IM (IM 153-2, IM 152-1) triggers a hardware interrupt on the DP master (for example, SIMATIC station S7-4xx) if:  
  - A message list (data record) in the IM is full.  
  - There is at least one message in a message list after 1 second. |
| 4    | CPU        | The CPU reads the reaction to the process alarm (OB 4x) from the data record. |
| 5    | IM_DRV     | The "IM_DRV" driver block generates an Alarm_T (Alarm_8 block with a time stamp in the first associated value) from the hardware interrupt. The Alarm_T transfers the message event to the connected operator stations. During configuration, the user specifies which signal transition (0->1 or 1->0) is to be reported as "INCOMING". The "OUTGOING" message is generated when the state reported by "INCOMING" changes. The signals with a time stamp are entered without gaps and in ascending chronological order in the message list of the operator station. Message texts are stored as default in IM_DRV (you can find additional information about this in the section "AS Process Control Message for Time Stamp Faults") and can be adapted (you can find additional information about this in the section "Assigning Message Texts"). |
| 6    | Synchronization | All the operator stations and SIMATIC stations used in the system must be supplied with the same time-of-day:  
  - The time master regulates the time-of-day synchronization for time stamping.  
  - Various time masters are available, for example:  
    - "Real-time transmitter for Industrial Ethernet"  
    - "SICLOCK TM"  
    - "Synchronization using an AS as time master" |
1.3 The Time Stamping Process in the Interface Module

The figure below shows how signal transitions are time stamped in the interface module (IM 153-2, IM 152-1).

- **Startup of the ET 200 station is completed. The interface module is ready for data communication with the DP master.**
  - **Is the suitable time stamp parameter available for configuration?**
    - **Yes**
      - **Clock set in the interface module?**
        - **No**
          - Error message on DP master; Digital input signals are not time-stamped. "Normal" data communication with DP master is not affected thereby.
        - **Yes**
          - **Time is set to 01.01.2006; 00:00**
    - **No**
      - **Read time frame**
      - **Set the clock of the interface module**
      - **Current time**
      - **Generate startup data:** read the states of the configured digital inputs; process interrupt on DP master for reading message buffer
      - **Monitoring of the configured digital inputs:** At change, generate message and enter it in the message buffer
      - **Diagnostics of the time frame:** At failure or time jump greater than the configured tolerance, generate special message and enter it in the message buffer
      - **Process interrupt on DP master, for reading message buffer**
      - With redundancy, the passive interface module always has an image of the time stamp messages.
2 Configuration

2.1 Hardware Configuration

Introduction
You use the distributed I/O based on ET 200M or ET 200iSP to acquire the signals.
This section provides an example of a hardware configuration needed for time stamping.

Example system with time stamping
The following figure shows an example of a system configuration with time stamping.
Example plant for a fault-tolerant automation system with time stamping

You can also use the time stamping function together with an S7-400H and distributed I/O:

- With an ET 200M, you can create a redundant configuration even to the sensor (fully redundant distributed I/O).
- With an ET 200iSP, you can connect to a redundant PROFIBUS DP (redundant interconnection).

Below you will see an example of a system using ET 200M.

Additional information

- You can find information about the IM 153-2 interface module in the manual *Distributed I/O Device ET 200M*.
- You can find information about the IM 152-1 interface module in the manual *Distributed I/O Device ET 200iSP*.
- You can find information about the redundant configuration of a distributed I/O in PCS 7 in the following documentation:
  - Function manual *Process Control System PCS 7; Fault-tolerant Process Control Systems*
  - Manual *Programmable Controller S7-400H, Fault-Tolerant Systems*
2.2 Special Features of the Interface Module

Introduction
The interface module (IM 153-2, IM 152-1) message buffer can become overloaded if there is a signal surge or if too many signals are constantly reported. Such an overload can result in the loss of messages. When planning your system you must ensure, therefore, that the interface module message buffer is not overloaded.

Message surge
When "unusual" events occur (for example, failure of a plant unit), signal transitions can occur almost simultaneously.
This behavior can be explained by analyzing the technological interrelationships.
Example
The frequency of signal transitions in a system can be projected as follows:
- On average, approximately 2% of the signals change per second.
- In the worst case (such as the failure of a plant unit), approximately 30% of the signals change state per second.

Message loss
If all the time-stamped signals of a system are collected on one ET 200 station, messages can be lost on the relevant interface module when "unusual" events occur. The message loss is displayed using AS process control messages depending on the cause (you can find additional information in the section "AS Process Control Messages for Time Stamp Faults").

Example for 10 ms time stamping
A system with ET 200M has 1,500 digital signals in its final configuration:
- Based on the projection, 450 signals per second can change in this system in the worst case.
- When 128 signals (max. 8 digital input modules SM 321 each with 16 inputs) are configured in an ET 200M station, messages may be lost due to the following reasons:
  - Other system-internal messages are generated in addition to the process messages (you can find additional information in the section "AS Process Control Messages for Time Stamp Faults").
  - The following processing levels (interface module, IM_DRV blocks, AS message processing, OS message processing) require more time to evaluate process messages.
2.3 High-precision Time Stamping with 1 ms Accuracy

Rules for the configuration of high-precision time stamping with 1 ms accuracy

- Synchronize the automation system via a time master, such as SICLOCK TM.
- Use the following modules in the automation system:
  - Interface module IM 153-2 (as of 6ES7153-2BAx1-0XB0)
  - Digital input modules of the ET 200M
- Use the DI module 6ES7321-7BHxx-0AB0 for the high-precision time stamping.
- Plug the modules (DI module 6ES7321-7BHxx-0AB0) for processing the input signals with high-precision time stamping gapless beginning with slot 4.
- Configure the input delay for all digital inputs with high-precision time stamping identically to a minimum value (100 microseconds).
- Disable the process alarms for all digital inputs with high-precision time stamping.
- Ensure in the system configuration of the DP master system that there is no repeater in the signal path between the CPU of the automation system and an ET 200M, on which the digital inputs are acquired with high-precision time stamping.
- Do not evaluate the digital inputs with high-precision time stamping before the startup time of ET 200M has expired (at least 10 seconds).
- Use suitable sensors for acquiring the signals.

---

Note
Keep the properties of the sensors in mind.
Varying transitions of the input signals (pulse rise time, spikes, etc.) can affect the accuracy of the time stamping.

---

Restriction
The following events may decrease the accuracy of the time stamping:

- Processing of diagnostic results
- Firmware update
- Reading identification and maintenance information (I&M data)
- Other acyclical services

Scope of this Documentation
The accuracy of the time stamping applies to each DP master system.
2.4 System Planning and Configuration

Note
By implementing the steps listed below, you can ensure that messages are saved in the archive even when a buffer overflow occurs (for example, when a device failure occurs):

- When planning your system and during configuration, ensure that the signals to be acquired are distributed uniformly throughout the system.

- If you subsequently modify the configuration, check the load on the SIMATIC station (in "Module Information - Online"). Therefore, in SIMATIC stations with heavy loads only configure time stamping for relevant signals (you can find additional information in the section "Basics of High-Precision Time Stamping").

- If you want to configure a large number of signals with time stamps, separate the analog and binary signals station-by-station.

- Configure a maximum of 128 digital inputs for each ET 200M station. Configure only digital inputs in the ET 200M stations.

- Set identical delay times for the inputs.
3 Components and Systems

3.1 Overview: Components and Systems

Introduction
This section presents the components and systems required for time stamping of digital input signals.

Systems
You use the PCS 7 OS HMI system to display and archive signals acquired with high-precision time stamping.

Components
The following components are used for converting time stamping of digital input signals:

- SIMATIC Station
- Communications Modules
- Distributed I/O
- IM_DRV block
- Time master

3.2 SIMATIC Station

SIMATIC Stations
You can use S7-400 and S7-400H series CPUs for processing messages and forwarding them to the operator stations in the SIMATIC stations.
3.3 Communication Modules

Communication Modules

You can use the following communication modules for time stamping:

- CP 443-1
- CP 443-5 Extended

**Note**
You can use the PROFINET DP connection of the CPU instead of the CP 443-5 Extended.

**Properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>CP 443-1</th>
<th>CP 443-5 Extended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used as ...</td>
<td>... interface to the plant bus</td>
<td>... interface to the distributed I/O device</td>
</tr>
<tr>
<td>Used to establish connection between ...</td>
<td>... SIMATIC station and operator station</td>
<td>... SIMATIC station and distributed I/O device</td>
</tr>
<tr>
<td></td>
<td>CP 443-5 Extended forwards the stamped messages transferred via the PROFINET DP (field bus) to the CPU.</td>
<td></td>
</tr>
<tr>
<td>Connection to bus system</td>
<td>Industrial Ethernet (plant bus)</td>
<td>PROFIBUS DP (field bus)</td>
</tr>
<tr>
<td>Order No.</td>
<td>6GK7 443-1EX11-0XE0</td>
<td>6GK7 443-5DX04-0XE0</td>
</tr>
<tr>
<td></td>
<td>6GK7 443-1EX10-0XE0</td>
<td>6GK7 443-5DX03-0XE0</td>
</tr>
<tr>
<td></td>
<td>6GK7 443-1EX02-0XE0</td>
<td>6GK7 443-5DX02-0XE0</td>
</tr>
<tr>
<td>Mounting</td>
<td>In the SIMATIC station slots in the rack (universal rack - UR)</td>
<td>In the SIMATIC station slots in the rack (universal rack - UR)</td>
</tr>
</tbody>
</table>
3.4 Distributed I/O

Distributed I/O

Time stamping can be configured with the following distributed I/O devices:

- ET 200M
- ET 200iSP

The following modules are used in the distributed I/O device to acquire signals:

- Interface module for PROFIBUS DP for preprocessing the signals
- Digital input modules for detecting signal transitions

Interface modules for PROFIBUS DP

<table>
<thead>
<tr>
<th>Accuracy</th>
<th>Order No.</th>
<th>Distributed I/O device</th>
<th>Module</th>
<th>Product Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 ms</td>
<td>6ES7 153-2BA01-0XB0</td>
<td>ET 200M</td>
<td>IM 153-2</td>
<td>All</td>
</tr>
<tr>
<td>1 ms</td>
<td>6ES7 153-2BA81-0XB0</td>
<td>ET 200M</td>
<td>IM 153-2</td>
<td>All</td>
</tr>
<tr>
<td>10 ms</td>
<td>6ES7 153-2BB01-0XB0</td>
<td>ET 200M</td>
<td>IM 153-2 FO</td>
<td>All</td>
</tr>
<tr>
<td>10 ms</td>
<td>6ES7 153-2BA00-0XB0</td>
<td>ET 200M</td>
<td>IM 153-2</td>
<td>&gt;=3</td>
</tr>
<tr>
<td>10 ms</td>
<td>6ES7 153-2BB00-0XB0</td>
<td>ET 200M</td>
<td>IM 153-2 FO</td>
<td>&gt;=3</td>
</tr>
<tr>
<td>10 ms</td>
<td>6ES7 153-2AA02-0XB0</td>
<td>ET 200M</td>
<td>IM 153-2</td>
<td>&gt;=7</td>
</tr>
<tr>
<td>10 ms</td>
<td>6ES7 153-2AB01-0XB0</td>
<td>ET 200M</td>
<td>IM 153-2 FO</td>
<td>&gt;=6</td>
</tr>
<tr>
<td>20 ms</td>
<td>6ES7 152-1AA00-0AB0</td>
<td>ET 200iSP</td>
<td>IM 152-1</td>
<td>1.0 and higher</td>
</tr>
<tr>
<td>20 ms</td>
<td>6ES7 152-1AA00-0AB0 (for redundant interface module)</td>
<td>ET 200iSP</td>
<td>IM 152-1</td>
<td>&gt;=2.0</td>
</tr>
</tbody>
</table>
Digital Input Modules

<table>
<thead>
<tr>
<th>Order No.</th>
<th>Distributed I/O device</th>
<th>Module</th>
<th>Used as</th>
</tr>
</thead>
<tbody>
<tr>
<td>6ES7 321-7BH00-0AB0</td>
<td>ET 200M</td>
<td>SM 321</td>
<td>Module for acquiring process signals with 16 electrically isolated inputs (24 V DC) and diagnostic messages</td>
</tr>
<tr>
<td>6ES7 321-7BH01-0AB0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6ES7 321-7TH00-0AB0</td>
<td>ET 200M</td>
<td>SM 321</td>
<td>Module for acquiring process signals with 16 inputs (NAMUR)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6ES7 321-7RD00-0AB0</td>
<td>ET 200M</td>
<td>SM 321</td>
<td>Module for acquiring process signals with 16 inputs (NAMUR)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Suitable for EX area</td>
</tr>
<tr>
<td>6ES7 131-7RF00-0AB0</td>
<td>ET 200/ISP</td>
<td>SM 131</td>
<td>Module for acquiring the process signal with 8 inputs (NAMUR)</td>
</tr>
</tbody>
</table>

Note
The signal comparability is ensured if:
- Uniform module types are used.
- The configurations of the modules are comparable (for example, the assigned delay time is identical for all inputs).

3.5 IM_DRV Diagnostics

Additional information
You can find additional information about diagnostic capabilities for the IM_DRV driver block in the Online Help for CFC.
3.6 Time Master

SICLOCK TM Time Master

The time master distributes the time signal to operator stations and SIMATIC stations that need to be synchronized.

You can use SICLOCK TM, for example, as the time master:

- The SICLOCK TM time master synchronizes connected stations requiring synchronization via Industrial Ethernet/Fast Ethernet.
- The SICLOCK TM time master can be synchronized using a time-of-day signal from a SICLOCK GPS decoder or SICLOCK DCFRS receiver, for example.

Applicable SICLOCK TM Components

You can find information and ordering data relating to the SICLOCK TM components that can be used in PCS 7 in the catalog ST PCS 7.1 (add-ons for PCS 7).
4 Configuring Time Stamps

4.1 Overview of Configuration Steps

Note
Only use enabled modules for time stamping.

Requirement
The components of the automation system are inserted in HW Config. The figure shows an example configuration for time stamping in HW Config:
## Overview of Configuration Steps

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>Configuring the CPs:</td>
</tr>
<tr>
<td></td>
<td>• Configuring the CP 443-1 (Industrial Ethernet)</td>
</tr>
<tr>
<td></td>
<td>• Configuring the CP 443-5 Extended</td>
</tr>
<tr>
<td></td>
<td>• Configuring the PROFIBUS Connection of the CPU</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>Configuring the ET 200M station:</td>
</tr>
<tr>
<td></td>
<td>• Power supply (no configuration necessary)</td>
</tr>
<tr>
<td></td>
<td>• Configuring the Interface Module: IM 153-2/IM 152-1</td>
</tr>
<tr>
<td></td>
<td>• Digital input modules:</td>
</tr>
<tr>
<td></td>
<td>- Configuring the SM 321 Digital Input Module</td>
</tr>
<tr>
<td></td>
<td>- Configuring the SM 131 Digital Input Module</td>
</tr>
<tr>
<td><strong>3</strong></td>
<td>Configuring the CPU Properties</td>
</tr>
<tr>
<td><strong>4</strong></td>
<td>Configuring the Symbols</td>
</tr>
<tr>
<td><strong>5</strong></td>
<td>Configuring the Input Signals</td>
</tr>
<tr>
<td><strong>6</strong></td>
<td>Generating Module Drivers</td>
</tr>
<tr>
<td><strong>7</strong></td>
<td>Compiling and Downloading the AS</td>
</tr>
<tr>
<td><strong>8</strong></td>
<td>Assigning Message Texts</td>
</tr>
<tr>
<td><strong>9</strong></td>
<td>Compiling the OS</td>
</tr>
</tbody>
</table>

### Additional information

- Online Help for *HW Config*
- List PCS 7 - Enabled modules
4.2 Configuring the CPs

The following is described in this section:

- Configuring the CP 443-1 (Industrial Ethernet)
- Configuring the CP 443-5 Extended
- Configuring the PROFIBUS Connection of the CPU

PROFIBUS Master

The PROFIBUS master is the component that distributes the system time to the PROFIBUS.

You can use the following components as the PROFIBUS master:

- CP 443-5 Extended
- Internal PROFIBUS connection of the CPU
4.2.1 How to Configure the CP 443-1 (Industrial Ethernet)

**Requirement**

A CP 443-1 is configured in the configuration table for the SIMATIC station (type of CP: see section "Components and Systems > Communication Modules").

**Procedure**

1. Select the CP 443-1 in HW Config.
2. Select the menu command **Edit > Object Properties**.
3. In the "Time-of-Day Synchronization" tab, select the "Activate SIMATIC time-of-day synchronization" check box:

   ![Properties - CP 443-1](image)

4. Click "OK" to apply the settings.
4.2.2 How to Configure the CP 443-5 Extended

Requirement

A CP 443-5 Extended is configured in the configuration table for the SIMATIC station (type of CP: see section "Components and Systems > Communication Modules").

Procedure

1. Select the CP 443-5 Extended in HW Config.
2. Select the menu command Edit > Object Properties.
3. In the "Operating Mode" tab, activate the "DP master" check box.

4. Select the "Options" tab.
5. In the "Time-of-Day Synchronization" group, click "From station to LAN". The time-of-day frames of the time master are then forwarded to the PROFIBUS.

6. Click "OK" to apply the settings.
4.2.3 How to Configure the PROFIBUS Connection of the CPU

Requirement
The S7-400 CPU has been configured in the configuration table.

Rules for Assigning the Time Interval
The following rules should be observed when assigning the time interval for the PROFIBUS connection of the CPU as described below.

The synchronization time interval setting depends on the interface modules (IM 153-2, IM 152-1) that are connected to the DP master systems:

<table>
<thead>
<tr>
<th>Property</th>
<th>Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>IM on the DP master system</td>
<td>If only interface modules (IMs) with a variable time interval (such as the IM153-2BA00) are used on the DP master system, set the synchronization time interval of the CPU to 10 seconds.</td>
</tr>
</tbody>
</table>
| IMs with the same time interval (fixed or variable) are connected to the DP master system. | Setting for synchronization of the DP slaves:  
  • If all DP slaves on the DP master system expect a time interval of one second for the synchronization, set the time interval for the synchronization for the CPU to 1 second.  
  • If all DP slaves on the DP master system expect a time interval of ten seconds for the synchronization, set the time interval for the synchronization for the CPU to 10 seconds. |
| IMs with different time intervals (fixed or variable) are connected to the DP master system. | If you use interface modules (IM) with different time intervals on a DP master system, set the minimally required time interval for the respective DP master system (see rule for: IM with same time interval on the DP master system). |

Rules for optimization:

| Multiple synchronization | Avoid multiple synchronization. Set the same interval values for all synchronizations.  
  • Set the synchronization interval for synchronization of the DP slaves.  
  • Set the synchronization interval for the time master that synchronizes the system. |
| Minimize the load on the CPU | If there are DP slaves in the system that expect a synchronization interval of 1 second, you can minimize the load on the CPU by making the following setting:  
  • Set the synchronization interval for the time master of the system to 10 seconds.  
  • Set the synchronization interval for the DP slaves to 1 second. |
Configuring Time Stamps

**Procedure**

1. Select the PROFIBUS connection of the CPU in HW Config.
2. Select the menu command **Edit > Object Properties**.
3. In the "Operating Mode" tab, activate the "DP master" check box.
4. Select the "Clock" tab.

**Note**

The setting options in the "Clock" tab depend on the interface module (IM) used.
5. Select "As master" in the "Synchronization mode" list. The time-of-day frames of the time master are then forwarded to the PROFIBUS.

Note
When making a setting from the "Time Interval" drop-down list, keep in mind that the setting options depend on the interface modules (IM) used. Read the "Rules for Configuring the Time Interval" in this section.

6. Click "OK" to apply the settings.
4.3 Configuring the ET 200 Station

4.3.1 Setting Options on the ET 200 Station

Hierarchy of Settings

<table>
<thead>
<tr>
<th>Hierarchy of Settings</th>
<th>On level …</th>
<th>… Set in HW Config</th>
<th>Affects</th>
<th>Setting options</th>
</tr>
</thead>
</table>
| DP slave (Rack)       | Interface module properties | All digital input modules in an ET 200 station | • Time stamping on/off  
• Rising or falling edge (see section "Examples of Settings for IM 153-2 Interface Module") |
| Module                | Digital input module properties | All channels of a digital input module | • Time stamping on/off  
• Rising or falling edge (see section "Examples of Settings for SM 321 Digital Input Module") |
| Channel               | Digital input module properties | One single channel of a digital input module | • Time stamping on/off  
• Rising or falling edge (see section "Examples of Settings for SM 321 Digital Input Module") |

Note
The lower-level settings are overwritten by the activation/passivation at a high-level location (for example, on the DP slave).
4.3.2 How to Configure the Interface Module

Requirements

- A DP master system is configured on a CP 443-5 Extended or on the PROFIBUS connection of the CPU.
- At least one interface module with digital input modules is configured for time stamping on the DP master system (type of digital input module: see section "Components and Systems > Distributed I/O").

Procedure

1. Select the interface module in HW Config.
2. Select the menu command Edit > Object Properties.
3. In the "Name" input box on the "General" tab, enter a unique name for the interface module. A unique name makes it easier to assign program blocks in other configuration tasks and messages.

4. Open the "Time-of-Day Stamp" tab.

**Note**

The "Time-of-Day Stamp" tab is available in the "Object Properties" dialog box for the interface module only if you have configured at least one digital input module that supports time stamping in the ET 200 station (see "Setting Options on the ET 200 Station").

5. Select the "Time Stamp" check box in the "Presetting of All Inputs" group.
6. Specify the edge of the process signal from the IM that should be interpreted as an "incoming event". The corresponding signal transition is then interpreted as an "outgoing" signal. Click the radio button corresponding to the desired signal transition:
   - "Falling Edge 1 -> 0" or
   - "Rising Edge 0 -> 1"

   When the static state of a signal changes, a message is generated at this point in time.

7. Click "OK" to apply the settings.

Notice!
The settings in the "DP Slave Properties" dialog box apply to all channels of the digital input modules with time stamping used in this ET 200 station. A change in the "Presetting of All Inputs" field affects the settings for all inputs of this ET 200 station.
4.3.3 Examples of Settings for IM 153-2 Interface Module

Example 1
IM 153-2 - time stamping enabled for the entire ET 200M station (or only one module with time stamping in this ET 200M station):

Example 2
IM 153-2 - time stamping disabled for the ET 200M station:
Example 3

IM 153-2 - time stamping enabled for (individual) modules or (individual) channels:

<table>
<thead>
<tr>
<th>DP slave properties</th>
<th>Operating Parameters</th>
<th>Isochronous Mode</th>
<th>Time-of-Day Synchronization</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>General</td>
<td>Time-of-Day Stamp</td>
<td>Identification</td>
</tr>
<tr>
<td>Presetting of All Inputs</td>
<td>Time Stamp:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Edge Evaluation</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Incoming Event</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Presetting of All Inputs
  - Time Stamp: [ ]
  - Edge Evaluation:
    - Rising (Positive) Edge (1 -> 0)
    - Falling (Negative) Edge (0 -> -)
  - Channel Specific
4.3.4 How to Configure the SM 321 Digital Module

**Note**
You only need to read this section if you want to set time-of-day synchronization for each digital input module separately.

**Requirements**
- At least one ET 200M station is configured in HW Config.
- A digital input module SM 321 is configured in a slot of the ET 200M station (IM 153-2) (type of digital input module: see section "Components and Systems > Distributed I/O").

**Procedure**
2. Open the context menu, and select the menu command **Object Properties**.
3. Select the "Time Stamp" check box in the "Time-of-Day Stamp" tab, and click the radio button for the desired signal edge evaluation. You can find additional information in section "Examples of Settings for SM 321 Digital Input Module":
- For all inputs of a digital input module ("Presetting of All Inputs") or
- Separately for each input of a digital input module ("Individual Setting of the Inputs").
4.3.5 Examples of Settings for SM 321 Digital Input Module

Example 1
Module setting "Presetting of all inputs" selected:

Example 2
Module setting "Individual setting of the inputs" (channel-specific) selected:
### 4.3.6 How to Configure the SM 131 Digital Module

**Note**

You only need to read this section if you want to set time-of-day synchronization for each digital input module separately.

**Requirements**

- An ET 200iSP station is configured in HW Config.
- A digital input module SM 131 (8 DI NAMUR) is configured in a slot of the ET 200iSP station (IM 152-1) (type of digital input module: see section “Components and Systems > Distributed I/O”).

**Procedure**

1. Select the SM 131 digital input module in the IM 152-1.

2. Open the context menu, and select the menu command **Object Properties**.
3. Select the "Time Stamp" check box in the "Time-of-Day Stamp" tab, and click the radio button for the desired signal edge evaluation. You can find similar information about this in the section "Example for Setting on the Digital Input Module SM 131":

- For all inputs of a digital input module ("Presetting of All Inputs") or
- Separately for each input of a digital input module ("Individual Setting of the Inputs")
4.3.7 Example for the Settings on the Digital Input Module SM 131

Example

Module setting "Presetting of all inputs" selected:

![Properties dialog box for configuring time stamps on SM 131 module]
4.4 Configuring the CPU Properties

4.4.1 How to Configure the CPU Properties

Procedure

1. Select the CPU in HW Config.
2. Select the menu command **Edit > Object Properties**.
3. Select the "Cycle/Clock Memory" tab.
4. Select "Only for incoming and outgoing errors" in the "OB85 call up if I/O access error" list.
5. Click "OK" to apply the settings.
4.5 Configuring the Symbolic Names

4.5.1 How to Configure Symbolic Names for Signals

Introduction
You can assign symbolic names to signals. Simple identification of the signals makes the interconnection of the driver blocks easier.

Requirements
- The project is open in the Component View of SIMATIC Manager.
- The path to the AS is set.
- HW Config is open.

Procedure
Perform the following tasks for all digital input modules:
1. Select a digital input module in HW Config.
2. In the configuration table for the module, select a row in which an address of the process image is assigned.
3. Select the menu command Edit > Edit Symbols.
4. Enter the symbols (symbolic names) for the assigned inputs of modules with time stamping.
    You can apply the addresses as symbols by clicking the "Add to Symbol" button. You can change the symbol name in the "Edit Symbols" dialog box or in the symbol table (for example, Symbol = "Chart_Meas" - a maximum of 24 character are allowed).
4.6 Configuring the Input Signals

4.6.1 How to Configure the Input Signals

Procedure

1. Select the "VALUE" input of the CH_DI block in the CFC chart.
2. Select the menu command Insert > Interconnection to Address. The "Insert Interconnection to Address" dialog box opens.
3. Select the row with the corresponding input and double-click in the row.

Result

The "Value" input of the CH_DI block is interconnected:
4.7 Generating Module Drivers

4.7.1 How to Generate Module Drivers

Introduction
The module drivers of PCS 7 are special blocks for diagnostics and reporting of errors during signal processing. You can automatically integrate these blocks in your charts using the command "Generate Module Drivers" if the following requirements are met.

Requirements
- The hardware has been configured with HW Config.
- The technological functions have been configured in the CFC.

Procedure
1. Open the project in SIMATIC Manager, and select the menu command View > Component View.
2. Select the chart folder of a S7 program in the tree: Project\SIMATIC Station\CPUS7 Program\Charts.
3. Select the menu command Options > Charts > Generate Module Drivers.
   The "Generate Module Drivers" dialog box opens.
4. Click "OK" to generate the module drivers. If necessary, confirm the "Drivers from earlier version" message with "Yes".

Additional information
- You can find additional information and step-by-step instructions in the configuration manual Process Control System PCS 7; Engineering System.
4.8 Compiling and Downloading the AS

4.8.1 How to Compile and Download the AS

Options

The following options are available for compiling and downloading programs:

- You can use the commands for a single SIMATIC station.
- You can compile and download multiple SIMATIC stations with a single command.

Additional information

- You can find additional information and step-by-step instructions in the configuration manual *Process Control System PCS 7; Engineering System*. 
4.9 Assigning Message Texts

4.9.1 How to Assign Message Texts

Note
Message texts can be adapted by performing these additional configuration tasks (The tasks are optional and are not necessary for time stamping).

Introduction
This section explains how to change the text of specific user messages for signals with time stamping.

Requirement
- The AS is compiled.

Procedure
1. Open the project in SIMATIC Manager and select the menu command View > Component View.
2. Select the SIMATIC station in which the interface module for time stamping is located (for example, IM 153-2).
3. Double-click "Hardware" in the detail window. HW Config opens.
4. Select the interface module.
6. Select the "General" tab and enter the name of the interface module in the "Module" group.
7. Open the project in SIMATIC Manager, and select the menu command View > Component View.
8. Select the chart folder of a S7 program in the tree: Project\SIMATIC Station\CPU\S7 Program\Charts.
9. Select the menu command Options > Charts > Chart Reference Data. The "Chart Ref: Display Chart Reference Data" dialog box opens.
10. Select the menu command View > Block Types. The "(S7 Program) (Block Types)" dialog box opens.
11. Click "Block type" in the table heading. 
The entries are sorted alphabetically.

12. Search the selection list for the block with the following entries:
   - Table column "Block Type" = IM_DRV and
   - Table column "Block" = "Name of the interface module"_1 (see step 6)

13. Double-click the block type IM_DRV in the located table row.
   The CFC chart containing the searched-for IM_DRV block opens and the IM_DRV is selected.

   The "Properties - Block" dialog box opens.

15. Click "Messages" in the "Special Properties" group.
   The "PCS 7 Message Configuration" dialog box opens.

16. If needed, change the texts of the signal-specific user messages for the message name areas "EV_ID_01" to "EV_ID_16" in the "Event" area of the table.

17. Click "OK" to apply the settings.

18. Compile the AS again.

Additional information

- You can find additional information about message configuration in the STEP 7 online help under the topic "How to Create Block-Related Messages for the Project".
4.10 Compiling the OS

4.10.1 How to Compile the OS

Options

The following options are available for compiling the operator station(s):

- You can compile a single operator station.
- You can compile multiple operator stations.

Additional information

You can find additional information and step-by-step instructions in the configuration manual *Process Control System PCS 7; Operator Station.*
5 AS Process Control Messages in the Event of Time Stamp Faults

5.1 Time Stamp Faults

Introduction

This section describes the AS process control messages that are generated when faults occur in the time stamping.

You can find information about editing the message texts in the section "Configuration of Time Stamping > Assigning Message Texts".

Overview of AS process control messages

The following AS process control messages can be generated for time stamp faults:

- Startup data
- Time-of-day message frame error
- Time difference between the message frame time stamp and the real-time clock may cause inaccuracy
- STOP of the time stamp function
- Message loss at IM (buffer overflow)
- Redundant changeover
- Redundancy_info_loss error
5.2 AS process control message "Startup data"

Meaning

The AS process control message "Startup data" indicates a start/restart of the interface modules (for example, IM 153-2).

Messages

- "Startup data" with the signal status "INCOMING"
- "Startup data" with the signal status "OUTGOING"

Description

1. After the start/restart, the interface module sends the signal for the AS process control message "Startup data" with the signal status "INCOMING" to the CPU.
2. The interface module then sends messages signaling the static state of all configured process signals. Based on the process signal, the interface module derives the signal to be sent according to the configuration:

<table>
<thead>
<tr>
<th>Status Process Signal</th>
<th>Configured Edge Evaluation of Incoming Event:</th>
<th>Interface Module (Signal Message from Startup)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0 -&gt; 1</td>
<td>OUTGOING</td>
</tr>
<tr>
<td>1</td>
<td>0 -&gt; 1</td>
<td>INCOMING</td>
</tr>
<tr>
<td>1</td>
<td>1 -&gt; 0</td>
<td>OUTGOING</td>
</tr>
<tr>
<td>0</td>
<td>1 -&gt; 0</td>
<td>INCOMING</td>
</tr>
</tbody>
</table>

3. Following this, the interface module sends the signal for the AS process control message "Startup data" with the signal status "OUTGOING".
Message Processing in PCS 7

1. The signal for "Startup data" with the signal status "INCOMING" is detected and the AS process control message "Startup data" is entered in the message list with the signal status "INCOMING".

2. In the CPU, the message block compares the signal messages representing the static state of the process signals with the last stored state of the signals. If there are signals whose states are different, messages are entered in the message list:

<table>
<thead>
<tr>
<th>Interface Module (Signal Message from Startup)</th>
<th>Value Stored in the CPU (Message Block)</th>
<th>Message in Message List and Archive</th>
</tr>
</thead>
<tbody>
<tr>
<td>INCOMING</td>
<td>INCOMING</td>
<td>---</td>
</tr>
<tr>
<td>INCOMING</td>
<td>OUTGOING</td>
<td>OUTGOING</td>
</tr>
<tr>
<td>OUTGOING</td>
<td>OUTGOING</td>
<td>----</td>
</tr>
<tr>
<td>OUTGOING</td>
<td>INCOMING</td>
<td>INCOMING</td>
</tr>
</tbody>
</table>

3. The OS identifies the signal for the startup data. The AS process control message "Startup data" is entered in the message list with the signal status "OUTGOING".
5.3 AS process control message "Time-of-day message frame error"

Meaning
The AS process control message "Time-of-day message frame error" indicates an error in the time-of-day synchronization of the interface module (for example, IM 153-2).

Messages
- "Time-of-day message frame error" with the signal status "INCOMING"
- "Time-of-day message frame error" with the signal status "OUTGOING"

Description
The interface module expects a time-of-day frame from the time master within the configured interval (every second, for example).

If the time-of-day frame of the master is not received three times in succession, the interface module continues to operate with the internal time and sends the message "Time-of-day message frame error" with the signal status "INCOMING" to the operator station.

Once the next valid time-of-day frame arrives, the internal clock of the interface module is synchronized and the message "Time-of-day message frame error" with the signal status "OUTGOING" is triggered.
5.4 AS process control message "Time difference between the message frame time stamp and the real-time clock may cause inaccuracy"

Meaning
The AS process control message "Time difference between the message frame time stamp and the real-time clock may cause inaccuracy" indicates a time change or time difference in the interface module (for example, IM 153-2).

Messages
- "Time difference between the message frame time stamp and the real-time clock may cause inaccuracy" with the signal status "INCOMING"
- "Time difference between the message frame time stamp and the real-time clock may cause inaccuracy" with the signal status "OUTGOING"

Description
The two messages are sent one after the other in the following situation:
- When a signal arrives at the interface module, there is a difference between the synchronous time and the internal time of the interface module.
- The difference between the times is greater than half the accuracy of the time stamp.

Example: The difference is > 5 ms with time stamping accuracy of 10 ms. The time of the interface module is then synchronized.
- The message with the signal status "INCOMING" receives the time stamp before synchronization.
- The message with the signal status "OUTGOING" receives the time stamp after synchronization.

Based on these messages, you can check whether the internal clock of the interface module has been set forward or back.
5.5 AS process control message "STOP of the time stamp function"

Meaning
The AS process control message "STOP of the time stamp function" indicates a time stamp fault of the interface module (for example, IM 153-2).

Messages
- "STOP of the time stamp function" with the signal status "INCOMING"
- "STOP of the time stamp function" with the signal status "OUTGOING"

Description
If the connection between the DP master and the interface module breaks down, signals are no longer given time stamps. This might occur, for example, following failure of the CP or a break on the bus cable. A message to this effect is entered in the internal message list.
- Signal time stamping is stopped from the moment the message with the signal status "INCOMING" is generated.
- Signal time stamping is reactivated once the message with the signal status "OUTGOING" is generated.
- Once the message "STOP of the time stamp function" with the signal status "OUTGOING" is generated, the interface module starts up again.
5.6 AS process control message "Message loss at IM (buffer overflow)"

Meaning
The AS process control message "Message loss at IM (buffer overflow)" indicates a loss of messages due to an overflow of the message buffer of the interface module (for example, IM 153-2).

Messages
- "Message loss at IM (buffer overflow)" with the signal status "INCOMING"
- "Message loss at IM (buffer overflow)" with the signal status "OUTGOING"

Description
The AS process control message is generated in the two following situations:

<table>
<thead>
<tr>
<th>Buffer Overflow Due to External Causes</th>
<th>Buffer Overflow Due to Internal Causes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Examples of potential causes:</td>
<td>Example of a potential cause:</td>
</tr>
<tr>
<td>• Failure of the operator station</td>
<td>The signals in the I/O change so quickly that the signal transitions can no longer be entered in the message lists.</td>
</tr>
<tr>
<td>• Failure or overload of the plant or field bus</td>
<td>Remedy: Distribute the signals over several interface modules or reduce the number of signals with time stamping.</td>
</tr>
<tr>
<td>• Failure or overload of the DP master (CPU)</td>
<td>Remedy: Correct the source of the problem</td>
</tr>
</tbody>
</table>

A message to this effect is entered in the internal message list.
- Incoming messages cannot be saved from the moment the message with the signal status "INCOMING" is generated.
- Incoming messages can be saved again once the message with the signal status "OUTGOING" has been generated.
5.7 AS process control message "Redundant changeover"

Meaning
The AS process control message "Redundant changeover" is output when there is a changeover between active and passive interface modules (for example, IM 153-2).

Messages
- "Redundant changeover" with the signal status "INCOMING"
- "Redundant changeover" with the signal status "OUTGOING"

Description
The AS process control message "Redundant changeover" indicates this period of interruption.

Time stamps are not applied during the period of the failover.
- Time stamping is deactivated from the moment the message with the signal status "INCOMING" is generated (start of the failover between the active and passive interface modules).
- Time stamping is reactivated once the message with the signal status "OUTGOING" is generated.
5.8 AS process control message "Redundancy_info_loss error"

**Meaning**

The AS process control message "Redundancy_info_loss error" indicates an error when signals are exchanged between the passive interface module (for example, IM 153-2) and the active interface module.

**Messages**

- "Redundancy_info_loss error" with the signal status "INCOMING"
- "Redundancy_info_loss error" with the signal status "OUTGOING"

**Description**

During error-free operation, the passive interface module receives information about the current state of the I/O from the active interface module:

- There is a signal exchange error from the moment the message with the signal status "INCOMING" is generated.
- As soon as the I/O state has been synchronized between the active and passive interface modules, the message with the signal status "OUTGOING" is output.
6 Diagnostics and Troubleshooting

6.1 Overview: Diagnostics and Troubleshooting

Overview

You will find information about the following topics in the sections below:

- Time Stamp Diagnostics
- Checking the Message Path
- CP Diagnostics
- Checking the Time
- IM_DRV Diagnostics
- Redundancy Diagnostics for H Systems
- Diagnostics for the Interface Module

6.2 Time Stamp Diagnostics

Edge Transition

The interface module (for example, IM 153-2) with the "time stamping" function can store the times of edge transitions and pass them on to the CPU by means of data records.

The interface module indicates the transfer request for a data record via a hardware interrupt OB.

The startup information (for example, OB 40) contains additional information.

Failure of the Time-of-Day Synchronization

When the time stamp function is activated, among other things the DP slave sends the special "Time-of-day message frame error INCOMING/OUTGOING" message during startup.

This message indicates whether or not time-of-day synchronization has failed.

The message indicating failure of time-of-day synchronization can be signaled by the CPU during a transition from STOP to RUN (to the logged-on OS, for example).
Failure of Higher-Level Time-of-Day Synchronization

If the external time-of-day synchronization fails, all underlying systems continue to be synchronized, provided that the highest-level module in the hierarchy is capable of this function (for example, the CPU).

- The valid value for the execution time of one program cycle for an interface (time interval Tcyc) is determined from the configured value or from the value derived from an algorithm.
- The time slave detects the failure based on the following criterion:
  Time slave: Failure of time synchronization frame > 3 * Tcyc
- If a failure of the frame is detected by a module, the module itself sends time synchronization message frames to the underlying buses, provided it has this capability. On these buses, the module is the time master.
  - Local synchronization takes place.
  - When local synchronization is used, the chronological sequence of signals can only be evaluated accurately for the signals belonging to the underlying subsystems.

Note
If no time interval is configured for the time slave, the default "synchronization interval of the synchronization frame" applies.

6.3 How to Check the Message Path

Notice
The procedures described here disturb the function of the line involved.

Checking Time-of-Day Synchronization

If time-of-day synchronization is functioning, break the connection to the clock. The IM reports the synchronization failure to the OS via block IM_DRV after three seconds.

Checking Non-functioning Time Stamping

1. Switch off the CP 443-5.
   WinCC shows a message about a failure of the DP master system.
2. Switch the interface module (for example, IM 153-2) off.
   WinCC shows a message about a failure of the DP master system.

Additional information

- Section "AS process control message "Time-of-day message frame error"
6.4 How to Perform CP Diagnostics

Introduction
You perform CP diagnostics in the following situations:
- When the CP 443-1 cannot be synchronized.
- When the CP 443-5 Extended supplies no signals or the signals are corrupt.

Performing Diagnostics when CP 443-1 Cannot be Synchronized
1. Open the project in SIMATIC Manager and select the menu command View > Component View.
2. Open HW Config.
3. Select the menu command Station > Open Online.
4. Select the CP 443-1.
5. Select the menu command PLC > Module Information.
6. In the dialog box, click "Special Diagnostics". The NCM S7 Diagnostics opens. If the NCM S7 Diagnostics cannot be started, the connection between the programming device/PC and the CP 443-1 is disrupted.
7. Note the MAC address setting of the CP 443-1 under "Industrial Ethernet."
8. Compare the MAC address setting of the CP 443-1 to the desired device address.

Performing Diagnostics when CP 443-5 Extended Supplies No Signals or the Signals Are Corrupt
1. Open the project in SIMATIC Manager and select the menu command View > Component View.
2. Open HW Config.
3. Select the menu command Station > Open Online.
4. Select the CP 443-5 Extended.
5. Select the menu command PLC > Module Information.
6. In the dialog box, click "Special Diagnostics". The NCM S7 diagnostics tool opens. If the NCM S7 Diagnostics cannot be started, the connection between the programming device/PC and the CP 443-5 Extended is disrupted.
7. Select the diagnostic buffer.
8. Compare the time stamp of the diagnostic messages with the CPU time of day.
9. Perform an action that will generate specific messages, such as activating an interface module.
6.5 How to Check the Time in the CPU

Procedure - Verifying "Time-of-Day Running"

Select the SIMATIC Manager menu command PLC > Set Time and Date, to check the module time in the CPU.

Possible displays:
- Time running
- Time not running

Additional Procedure If "Time-of-Day Running"

1. Select the CPU in HW Config.
2. Select the menu command Edit > Object Properties.
3. Select the "Diagnostics/Clock" tab.
4. In the "Clock" group, select "As Slave" as the synchronization mode in the "Synchronization – in the AS" list:
5. Open the project in SIMATIC Manager and select the menu command View > Component View.

6. Select the path Project\SIMATIC Station\CPU in the tree view.

7. Select the menu command PLC > Set Time and Date.

8. Deactivate the check box "Set from PG/PC".

9. Enter any time in the "Time of day" entry box in the "Module Time" group. Click "Apply".

10. Select the menu command PLC > Set Time and Date. Check the time.

Result

- If the module time cannot be set, the CPU receives a time signal. The system is synchronized. The clock and Ethernet-CP are operational.
- If the module time can be set, the CPU does not receive a time signal. The system is not synchronized. The might occur, for example, if the time master is inoperative or is disconnected from the bus.

Time not running

Potential cause: CPU at STOP

1. Open the project in SIMATIC Manager and select the menu command View > Component View.

2. Select the path Project\SIMATIC Station\CPU in the tree view.

3. Select the menu command PLC > Operating Mode to check the CPU and the operating mode of the CPU.
6.6 IM_DRV Block

**IM_DRV Driver Block**

If you use time stamping, the system incorporates the IM_DRV driver block (see figure below) into a CFC with the "Generate Module Drivers" function:

- One IM_DRV driver block is incorporated for each interface module in the system CFC (the name of the system CFC begins with the "@" character).
- The IM_DRV forms the interface between an interface module and the operator station in a SIMATIC station.
- The IM_DRV reads the messages from the message buffer (maximum of 20 messages per buffer) of an interface module and transfers them to the operator station.

```
IM_DRV
Time Sta
```

- CBL 6/5
- QIACRF
- QPIARF
- QPADF
- QDPARF
6.7 Redundancy Diagnostics for H Systems

Description
Redundancy is present in respect of time stamping with H systems that feature two interface modules (for example, IM 153-2) in the following cases:

- The active and passive interface module has been updated without errors.
- Communication between the two interface modules is operating without errors.

<table>
<thead>
<tr>
<th>LED</th>
<th>Color</th>
<th>Active interface module</th>
<th>Passive interface module</th>
</tr>
</thead>
<tbody>
<tr>
<td>SF</td>
<td>Red</td>
<td>Static display (LED not flashing): Not relevant</td>
<td>Static display (LED not flashing): Not relevant</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the SF LED does not flash, there is a redundancy fault. The LED flashes for approximately 20 seconds after changing to the redundant mode.</td>
<td>If the SF LED does not flash, there is a redundancy fault. The LED flashes for approximately 20 seconds after changing to the redundant mode.</td>
</tr>
<tr>
<td>BF</td>
<td>Red</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>ACT</td>
<td>Yellow</td>
<td>On</td>
<td>Off</td>
</tr>
<tr>
<td>ON</td>
<td>Green</td>
<td>On</td>
<td>On</td>
</tr>
</tbody>
</table>

Loss of redundancy (failure of an interface module) is reported outside the IM_DRV using the SUBNET and RACK blocks.
6.8 Diagnostics for the Interface Module

Additional information

- You can find information about the IM 153-2 interface module in the manual *Distributed I/O Device ET 200M.*
- You can find information about the IM 152-1 interface module in the manual *Distributed I/O Device ET 200iSP.*
## Index

### A

**Accuracy** 1-1, 1-2  
- time stamping 1-1  
**Accurately-timed detection** 1-3  
- time stamping 1-3  
**AS** 4-26  
- compiling and downloading 4-26  
- AS process control messages 5-1, 5-2, 5-4, 5-5, 5-6, 5-7, 5-8, 5-9  
- message loss at IM (buffer overflow) 5-7  
- Redundancy_info_loss error 5-9  
- Redundant changeover 5-8  
- startup data 5-2  
- STOP of the time stamp function 5-6  
- Time difference between the message frame time stamp and the real-time clock may cause inaccuracy 5-5  
- time-of-day message error 5-4  

### C

**Checking** 6-2, 6-4  
- disrupted time stamping 6-2  
- message path 6-2  
- synchronization 6-2  
- time in the CPU 6-4  
**Communication** 3-1  
- with operator station 3-1  
**Communication modules** 3-2  
- CP 443-1 3-2  
- CP 443-5 Extended 3-2  
- for time stamping 3-2  
**Compiling** 4-26, 4-29  
- AS 4-26  
- OS 4-29  
**Components** 3-1  
- Configuration notes 2-5  
**Configuring** 4-2, 4-3, 4-4, 4-5, 4-6, 4-10, 4-15, 4-21, 4-22, 4-24  
- CP 443-1 Industrial Ethernet 4-4  
- CP 443-5 Extended 4-5  
- CPUs 4-3  
- CPU properties 4-21  
- digital input module SM 321 4-15  
- IM 153-2 interface module 4-10  
- input signals 4-24  

**Diagnostics** 6-1, 6-7, 6-8  
- H systems 6-7  
- on the IM 153-2 6-8  
**ET 200iSP** 4-18, 4-20  
- digital input module example 4-18, 4-19  
- digital input module example 4-20  
- SM 131 example 4-20  
- SM131 4-18  

### E

**Entering** 4-27  
- message texts 4-27  
**PROFIBUS connection of the CPU** 4-6, 4-7  
- Symbols 4-23  
- time stamping 4-1  
**CP 443-1** 6-3  
- cannot be synchronized 6-3  
**CP 443-1 Industrial Ethernet** 4-4  
- configuring 4-4  
**CP 443-5 Extended** 4-5, 6-3  
- configuring 4-5  
- corrupted signals 6-3  
- no signals 6-3  
**CP diagnostics** 6-3  
- CP 443-1 cannot be synchronized 6-3  
- CP 443-5 Extended - no or corrupted signals 6-3  
**CPs** 4-3  
- configuring 4-3  
**CPU** 6-4, 6-5  
- checking time 6-4  
- time not running 6-5  
- time running 6-4  
**CPU properties** 4-21  
- configuring 4-21  

### D

**Diagnostics** 6-1, 6-7, 6-8  
- H systems 6-7  
- on the IM 153-2 6-8  
**Digital input module SM 131** 4-18, 4-20  
- configuring 4-18, 4-20  
**Disrupted time stamping** 6-2  
- checking 6-2  
**Distributed I/O** 3-3, 3-4  
- applicable modules for signal acquisition 3-3  
**Downloading** 4-26  
- AS 4-26  

### E

**Entering** 4-27  
- message texts 4-27  
**ET 200iSP** 4-18, 4-20  
- digital input module example 4-18, 4-19  
- digital input module example 4-20  
- SM 131 example 4-20  
- SM131 4-18
Index

ET 200M station 4-9
settings for time stamping 4-9
Examples 2-1, 4-13, 4-17
redundant system with
time stamping 2-1
settings for IM 153-2
interface module 4-13
settings on the SM 321 digital input
module 4-17
system with time stamping 2-1

F
Faults 5-1
in time stamps 5-1

G
Generating 4-25
module drivers 4-25

H
Hardware 6-7
diagnostics 6-7
High-precision time stamping with 1 ms
accuracy 2-4

I
IM 153-2 2-3, 6-8
diagnostics 6-8
Message loss 2-3
signal surge 2-3
special features 2-3
IM 153-2 interface module
configuring 4-10
examples of settings 4-13
IM_DRV block 3-4, 6-6
information 3-4
using for time stamping 6-6
Information 3-4
about IM_DRV block 3-4
Input signals 4-24
configuring 4-24

M
Message loss 2-3
to IM 153-2 2-3
Message path 6-2
checking 6-2
Message texts 4-27
assigning 4-27
Entering 4-27
Messages 5-1, 5-2, 5-3, 5-4, 5-5, 5-6, 5-7,
5-8, 5-9
message loss at IM (buffer overflow) 5-7
Redundancy_info_loss error 5-9
Redundant changeover 5-8
startup data 5-3
STOP of the time stamp function 5-6
Time difference between the message
frame time stamp and the real-time
clock may cause inaccuracy 5-5
time stamp faults 5-1
time-of-day message error 5-4
Module driver 4-25
Module drivers
generating 4-25

O
Operator station 3-1
communication with CPU 3-1
OS 4-29
compiling 4-29
Overview of diagnostics and
troubleshooting 6-1

P
PROFIBUS connection of the CPU 4-6
configuring 4-8

R
Redundancy for H systems 6-7
Diagnostics 6-7
Redundancy_info_loss error 5-9
AS process control message 5-9
Redundant changeover 5-8
AS process control message 5-8
Redundant system with time stamping
example 2-1

S
Sequence 1-4
time stamping 1-4
Settings 4-13, 4-17
IM 153-2 interface module
Examples 4-13
SM 321 digital input module
examples 4-17
Signal acquisition 3-3
applicable modules 3-3
via distributed I/O 3-3
Signal surge 2-3
on IM 153-2 2-3
Signals 4-22
assigning symbolic names 4-22
SM 131 4-20
example 4-20

Index-2
Index

SM 321 digital input module 4-15, 4-17
  configuring 4-15
  settings example 4-17
Startup data 5-2
  AS process control message 5-2, 5-3
  STOP of the time stamp function 5-6
  AS process control messages 5-6
  Symbolic names 4-22
  assigning to signals 4-22
Symbols 4-22
  configuring 4-22
Synchronization 6-2
  checking 6-2
System planning 2-5
  notes 2-5
system with time stamping 2-1
  example 2-1, 2-2
Systems 3-1

T

Time 6-4, 6-5
  checking in the CPU 6-4
  not running in CPU 6-4
  running in CPU 6-4
Time difference between the message frame time stamp and the real-time clock may cause inaccuracy 5-5
  AS process control message 5-5
  Time Master 3-5
  Time stamping 1-1, 1-3, 1-4, 2-1, 2-2, 3-1, 3-2, 4-1, 4-9, 5-1, 6-1, 6-2, 6-6
    accuracy 1-1
    accurately-timed detection 1-3
    checking 6-2
    communication modules 3-2
    configuring 4-1
    diagnostics 6-1
    features 1-1
    messages for faults 5-1
    plant-wide interrelationships 1-3
    requirements 1-1
    resolution 1-2
    sequence 1-4
    settings on the ET 200M station 4-9
    system configuration 2-1
    using 1-1
    using CPU 3-1
    using IM_DRV block 6-6
    Time stamping (10 ms) 1-1
    Time Stamping in the Interface Module 1-5
    Time-of-day message frame error 5-4
    messages 5-4

U

Use 6-6
  IM_DRV block for time stamping 6-6
Using 1-1
  time stamping 1-1, 1-2